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About this Document:  

The content of this document is an updated version of the documentation delivered with the add-in 

application. This document is intended for both end users and product software managers.   

 

Legal:  

Phocaz Inc., PhotoGeoDWG, the Phocaz icon and text are trademarks of Phocaz Inc.. AutoCAD, Civil 3D 

logos and images are registered trademarks of Autodesk. This document may be reproduced and 

redistributed as-is for administration of the add-in software only.   
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PhotogeoDWG Pro Reference 
 

Welcome to the professional version of PhotogeoDWG! Thousands have used the free version to 

document environmental projects, sign studies, equipment inspections, and more. Now you're about to 

take advantage of a fully integrated application that can use the coordinate geometries available in 

AutoCAD and Civil3D. In addition, you now have an expanded set of management tools that match your 

workflow - update the photo's data directly, place labels, thumbnails, and rotate the cameras to show 

orientation. 

Did you take a bunch of photos last month and now you have to share them with your design team? Are 

you like me, often forgetting where and why you took the photos? PhotogeoDWG can help by 

combining maps with geocoded photos you saved on a local drive, network drive, or cloud. Use 

PhotogeoDWG to import camera locations to a drawing automatically, insert the photo to better convey 

design intent, or provide detail to existing conditions drawings. PhotogeoDWG remains connected to the 

digital asset with xdata and hyperlinks - unload the plugin palette and you can still control click to 

navigate to the photo.  

 

 



PhotogeoDWG Reference  01.02.01 

Phocaz Inc. © 2018  5 | P a g e  
 

The following sections provide detailed information about the functions and features of this unique add-

in. Read it all, or use as a reference. If you don't find what you're looking for, check out our blog at 

www.phocaz.com. You can also follow us on Facebook, twitter, and LinkedIn. 

Overview 
What do you get in Pro? 

This list is a delta from the free beta released several months ago and from the free AutoCAD version 
available on. the Autodesk App Exchange. If you're new to PhotogeoDWG then scroll down to the next 
section. All features, new and old are documented. 
 
In the free version we demonstrate how to solve the basic problem of managing photos and projecting 
their GPS location to XYZ map coordinates. It used a basic algorithm for making this projection. In 
addition to this singular approach, we could only place camera markers (without direction) and 
placement of photos was done one at a time. Some great management tools were included, and you 
could read photos stored on a network drive or on a web server.  
 
The new version adds several new placement commands as well as support for all coordinate systems 
available in AutoCAD. Here's a list of new features... 

• Support for all AutoCAD coordinate systems. 
• Edit Photo Data 
• Automatic numbering and project names 
• Apply orientation to camera markers 
• Use custom level for camera marker 
• Select camera block and select from multiple blocks 
• Use custom blocks 
• Place labels in the drawing 
• Set a placement offset for labels 
• Use custom level for labels 
• Place a photo thumbnail in a drawing 
• Define the shape and size of the image 
• Set a placement offset for the image 
• Toolbox calculates coordinate projections 
• Edit the Info on the photos using the Edit Photo command 
• Bulk Edit the Photo Info 
• Move the markers and then update the photo’s Lat/Long Data 
• Works without Internet 
• Reverse projections XYZ to Lat/Long Data 
• Export photo data to CSV 
• Updated photo listing view with thumbnails and descriptions 

 

Ok, great list of features, but what can I do with it? Well imagine you're making an inventory of features 
along several miles of road as pre-engineering effort, or maybe you’re trekking along city sidewalks as 
part of an accessibility effort. Smart phones and digital cameras make it really easy to document existing 
conditions, take inventories, and capture just about anything you might be working on.  
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In the not so distant past, we would get back to the office and save the photos to a folder on our 
computer and probably to a network drive so others could use them. A month might go by before we 
went back and looked at the photos. Do you remember where the points of interest shown in these 
photos are or why you took them? Even if you get to them in a couple of days it's hard to remember 
where every photo was shot.  

How about this photograph?  

 

Would you remember where it was snapped? How about why you took it. PhotogeoDWG will 

automatically add the location of the photo to your CAD file showing you where you were standing 

when taking the photo. It will also show you the direction you were standing. And, you can add 

information directly attached to the photo describing why you took it and what to do next. 

 

Geocoded JPG 
When we take a photograph with our smartphones and digital cameras, information about the photo is 

saved to the jpg image file. This is what you can see when you right-click on the jpg in windows and 

select properties. 

 

 

This is called metadata. And there is some very useful data about the photo. Of course, we were most 

interested in the GPS coordinates - latitude, longitude, and elevation. If you type the latitude and 
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longitude coordinates into Google Maps search field it will show you where you took the photo. 

Amazing! 

 

CAD, Cloud, and Photos 
With PhotogeoDWG we set out to combine CAD, cloud, and photos - making the technology accessible 

from the design environment. Start by dumping all of your photos into a computer directory. Then, tell 

PhotogeoDWG where that folder is located and it will build a listing of the images conveniently 

displayed in a palette.  

Click on a photo name to view the image. At the same time PhotogeoDWG will locate the position of the 

photo on google maps - a quick easy reminder of where, and possibly why you took that photo. And, if 

you are still a little lost - click on the "open in google maps" button to get a street view. Your project site 

is probably there. No need for another site visit before your meeting. 
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With PhotogeoDWG you can also save your photos in the cloud. Upload your photos to your web server 

as jpg files, build a PhotogeoDWG library, and then share the photos with colleagues - in your office or 

around the world.  

In the past we would have tried to email photos or set up an ftp site where external partners could get 

the photos. With cloud collaboration you no longer have to send large emails - just send the library file 

and using PhotogeoDWG your partners can work with the files immediately. 

 

Maybe your partners and colleagues don't have PhotogeoDWG, yet. No problem. Send them your CAD 

file. When you place camera markers into a drawing, PhotogeoDWG adds a hyperlink. 

 

PhotogeoDWG provides several controls for managing camera markers. Bulk import camera locations, 

highlight camera markers, zoom to X,Y will help you manage and build your documentation. You can do 

all of this just by snapping a few photos with your smartphone. 
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Getting Started 
 

TPGPHOTOGEO 

Opens the PhotogeoDWG palette containing a datagrid view of the photos and their location along with 

a map viewer and an image viewer to display the selected photo. A second tab called Options allows you 

to select both a folder based album, or an online photo album library file. You can also use the options 

tab to create a new album library or edit an existing album library. A third tab labelled Tools provides 

GCS calculators.  

 

 

 

File Locations in this Reference Guide 
You may notice that there are two locations referenced in the examples below. The first location is the 

program directory\Contents\Resources\Datasets\. This is where the installer copies the samples. Some 

of the images below will show this location.  

For convenience, I have copied the content of Datasets to C:\demos\. Many of the examples below will 

refer to this location. For example, C:\demos\sample1\ or C:\demos\Sample2\. I recommend you make 

a copy of these files in a convenient location like C:\demos\. That way, if you want to recover, or start 

over you can just copy the files from the Datasets folder to this new folder. 

In production, you will probably save your images in a sub folder of your project. The only stipulation is 

that your drawings and the parent folder for the images reside in the same location. For example, I have 

created a project folder on my Z: drive containing my drawing and images folder.  
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Viewing Photos 
The first time you load PhotogeoDWG you will see the tool palette and it will be empty. It may be 

undocked. The tool palette works like others in AutoCAD and you can dock it as shown below. You might 

want to change the width to match your preferences. The minimum size is purposely small, so you may 

want to stretch it to see all of the command buttons located on the bottom quarter of the palette. 
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To get started click the options tab. Or easier, click the “Click Here!” button at the top of the palette.  

The options tab will also be empty, but to make getting started a little easier we have added a large "TRY 

SAMPLE" button. It's located in the yellow bar at the top of the dialog. Click it! 
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The Try Sample button will fill in Album Folder. Along with a sample library. We will look at libraries 

later. 
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Next. Click the “See Photos” button at the top of the palette. This will take you back to the main tab. It is 

no longer empty. The palette is populated with the files from the Photo Album and the first photo is 

selected for you. 
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When you change the photo album to point to your photos, the see photo button will not be available. 

Instead, you will select the main tab. Then at the bottom of the palette, in the controls panel you will 

select the FLD button. This will rebuild the list of photos with the pictures you snapped. Select one to 

see the image in the viewer panel. 

 

Here’s a step by step approach for loading your photos. I will use my Route 53 project to demonstrate. 

1) Select the Options Tab. 
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2) Select the browse button to the right of the Photo Album text box. 

 

3) Browse to your project images folder. In this example, my project images folder is C:\ 

Route53_Island_PreEng\images\dot1a\. 
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Several things happen when you select this new folder. A) Since it is no longer the demonstration 

dataset, the see photos button is turned off. B) The Photo Album Path changes to match the folder you 

just selected. And C) The photo list (think of it as a preview) shows the images found in this folder. 

 

4) Click the Main tab. 
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5) Click the FLD button.   

6) And then click on a photo in the data grid. 

 

 

This will load the image into the viewer, and it loads a map with a marker to show you the approximate 

location of where the photo was taken. 

 

Downloading and Working with the Samples 
With the latest version of Photogeo, we have some sample images you can use to get started. These are 

located on the downloads page https://phocaz.com/pgdwg  
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When you download this zip file, extract it to a folder you can read and write. I will use my demo folder, 

but you can use any drive or folder name that is appropriate for your design environment. 

Here are the steps for creating this project and a drawing with a coordinate system for this demo. 

 

1) Download the sample dataset by clicking the link. When finished you will get a notification that the 

zip file has been downloaded. This notification will differ from browser to browser.  

2) Open the folder containing the download. This is usually set to your default downloads folder.  

3) Create a folder called C:\Demonstration\. You can use a different drive and folder name.  
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4) Extract the contents of sampledataset.zip to this folder. When done your folder should look similar to 

the one below. 

 

 

If you expand images you will find the photos in dot1a folder. 
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5) Start Civil3D and save a drawing to C:\demo\d1.dwg. Of course, you can use any name you want. The 

only pre-requisite is that the drawing reside at the same level as the images folder. 

6) Start the PhotogeoDWG Add-in and then browse to this new photo album location (see page 12 for 

the steps). 

 

7) Click on the Main tab and then click on FLD to list the photos in this location. Your Main tab will look 

similar to the following. 
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8) Add a coordinate system.  

The quickest way to do this is using the insert by map feature. You can attach your own coordinate 

system using Civil3D and use your own imagery or cad linework. Either way will work just fine. But, the 

following approach is good for demonstration. 

A) Select the Insert tab from the ribbon menu. 

B) Select the Set Location command. You will need to be logged into A360 to use this feature. 
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You will use the Select From Map Option. 

 

C) Type the following address: 

405 Jordan Lane Huntsville AL 

 

D) Hit return then click the button labeled “Drop Marker Here”. 
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E) Click the Next button when it activates. 

 

This will take you to the next dialog where you will select a coordinate system. It might take a few 

seconds. There are over 6000 coordinates available, but the program has to figure out which ones are 

appropriate for the region you are working in. 
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F) Sort the coordinates by Reference when they finish loading. Just click the column header labeled 

reference. 

 

G) Select HARN/16.UTM-16F (this should be the first one in the list). 

H) Then click Next. 
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I) Select an origin point for the coordinate system. You can just click anywhere in the view, but I prefer 

to use 0,0,0 so that I can find this point again should I have to re-attach the coordinate system. 
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J) Select a rotation. 90 degrees works well for this example. 
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K) Zoom in - The Map will attach. You can zoom into the attachment point so that you can see the 

outlines of the buildings. Similar to the following. 

 

 

We now have a fully defined coordinate system for our model. And there’s a map so we can see where 

we are placing markers, photos, and labels. 

9) Place Camera Markers 

A) Select All photos. You can do this by right-clicking on the data grid and choose the first option in the 

pop-up menu. 



PhotogeoDWG Reference  01.02.01 

Phocaz Inc. © 2018  29 | P a g e  
 

 

B) Click the Place Camera Marker(s) command button. 

 

If you zoom in you will be able to see the details of the camera markers. Notice that they are also 

rotated to the direction the photographer as facing when taking the photos. 

 

10) Place Labels 

In this step we will change the label parameters so they place just to the right of the camera markers. 

A) Click on the options tab and then click on the + button to the right of “Label Settings”. 
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B) Set the data to label, and the offsets. For demonstration we will leave the level set to 0. 

When you click ok, any changes you make in this dialog are saved to the user’s application settings. The 

program will look these up when it needs them. Here are the settings for our example. 

 

 

Make your label settings look like these and then click OK. (Click cancel to dismiss the dialog without 

saving changes). 

C) Return to the Main Tab. Select all photos. Then run the Place Labels command. 

 

Our drawing now has camera locations and labels. 
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11) Where do the labels come from? In this step we will review the photo data. This data can be 

modified before the photos are added to the drawing using the Edit Photo Data command. 

 

Select the photo you want to edit first.  
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The Edit Photo Data dialog opens.  

 

It will let you change a lot of information that is attached directly to the photograph jpeg file. The data 

has already been added to the photo, but we can make changes (as long as the photo hasn’t been added 

to the drawing).You can use the navigation buttons (lower left) to move between photos. Close this 

dialog when you are finished reviewing the data. 

 

12) Place Photos 

Along with Markers and Labels, Photos can also be placed into the drawing. There are some settings that 

will make placing photo images much easier.  

Photo settings are located on the options tab. You access them by clicking the plus (+) button next to the 

image settings label. See step A. 
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A) Open the Image/Photo Settings by clicking the plus (+) signs to the right of the Image Settings label. 

 

This will expand the image settings. 

 

When expanded you can change the width and height of the images. Offset Y and Offset X tell 

PhotogeoDWG how far away from the marker origin to draw the photo. This is actually a raster 

referenced. This means that AutoCAD/Civil3D’s reference dialog to manage these images. 

B) Return to the main tab. 

Make sure that your drawing has been saved before running this command.  

• Select all photos in the photo list, or just the photos you want to insert into the drawing. 

• Click the Place Photos button. 
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In just a few short minutes you have located more than 30 photos on your drawing, added labels and 

thumbnails for each. 

The entities added to the drawing are standard to AutoCAD. The camera markers are blocks, the labels 

are multiline text, and the photo thumbnails are raster references. You can share this drawing with 

anyone. They do not have to have PhotogeoDWG. Only the drawing and the photo jpg files need to be 

shared.  

The remainder of this reference guide will look at the details of each feature including the advanced 

features like exporting to CSV, changing the photo resolution, synching moved camera markers, and 

bulk photo data edits.  

 

Google Maps API Key 

 

Maps API Key is where you enter the Google Maps API Key. The key is required by Google when 

requesting static map images which is what you are doing when you click on the photo list in the Main 

tab. The key is just a really long string of characters and it will be unique for you (or your team if you 

decide to just use one key for everyone). You don’t have to use the same key, but for small teams you 

are not likely to need more than one. Google uses a key so that they can charge a fee to users who are 
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high volume users of static maps. At present this is defined as a user who is requesting more that 25,000 

maps in a single day (the count resets every day). It’s unlikely that a single user, or even your team will 

reach this many map requests. 

PhotogeoDWG uses Google’s static maps to display the location of the photo in the top panel of the 

Main Tab.  

 

In older versions of PhotogeoDWG, we were able to request Google maps without a key. In the fall of 

2016, Google changed their policy and now require that the key be included with all requests.  

The maps will still display without the key – for now. What we have seen however, is that occasionally, 

Google blocks the request. We know this happens because the Map view is filled with Working Offline 

image, even though we have a connection and the Work Offline option is unchecked. We can also see 

the error in the program’s log file.  

 

 

Obtain and Add Your Google Maps API Key to PhotogeoDWG 

We have tried to make getting and setting your key as easy as possible, and it’s not really that hard. 

Click the Plus button next to the Maps API Key label to reveal the controls for managing the key with 

PhotogeoDWG. 
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The text field is where you will add the key string when you get it. You will probably want to start by 

clicking the button “Get a Google Maps API Key”. This will open the following web page. 

 

If for some reason the button on the Options Tab does not take you to this page then try the following 

link… 

https://developers.google.com/maps/documentation/static-maps/get-api-key 

When you get your key, copy and paste the key into the text box next to the Google Maps API label. 

PhotogeoDWG will append the key to map requests. We won’t show it here, because this is a secret key 

and you could get unscrupulous characters who might want to use your key for nefarious purposes. So, 

just to be safe, keep your key to yourself. And, if you forget, you can always return to this page. 

After you enter the key, click the “Test Google Maps API Key” button. If the key is good you will get an 

OK: Map Test Passed status displayed below this button. 

 

More About Usage Limits for Static Maps 
At the time we created this doc, users could create 25,000 static maps per day for free. That should be 

more than enough for your team.  

https://developers.google.com/maps/documentation/static-maps/usage-limits 

 

https://developers.google.com/maps/documentation/static-maps/get-api-key
https://developers.google.com/maps/documentation/static-maps/usage-limits
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Working in the Main Tab View 
You’ve already done a lot of things in the getting started section. Now we are going to take a deeper 

dive and examine some of the program details. Let’s start with features on the Main Tab. 

Primary Controls 
If you have worked through the getting started section, then you are already familiar with each of the 

commands located at the top of the Main Tab. Here are some details. 

 

The first three commands, starting from the left are the most commonly used commands – place 

markers, place photos, and place labels. Each of these commands requires that you first select photos 

from the photo list (see instructions below) and then just click the command you want to use. We 

decided to separate these command for those of you who prefer not to place all of these entities.  

 Place Markers – These are the camera markers. The markers are blocks read from the block 

library, defined on the options tab (see options tab section below).  

 

 Place Photos – Use this command to automatically place one or many photos into the drawing. 

The images are raster references of the jpeg photos. The default placement point is the same point as 

the marker. Use the offset values to displace the photo origin from the marker origin. (See options tab 

details below). 

 

 

 Place Labels – Use this command to add photo data to the drawing. There are five data fields 

saved on the photos. Each of these can be added to the label. The Label Settings located on the options 

tab let you decide which fields you want to label. (See options tab details below). 
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There are three more controls at the top of the Main Tab – More, Help, and Photo List Mode label. 

 More Commands – This control opens a pop-up menu with additional commands. The next 

section will provide details for each of these commands. 

 

 Help Command – opens this document. 

 Photo List Mode Label – this label indicates where the photos in the photo list come from.  

There are three places that the list can be read from,  

• a folder  

• a library album  

• the drawing  

We will see in the next section that this mode label will change based on which of the list commands we 

select in the More commands menu. 
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More Commands 
The more commands are hidden because they are not used as often as the Primary commands, but each 

has an important role. 

 

The first four commands from the top change the photo list view. A couple of things happen when you 

select one of these commands. First, the Photo Mode Label updated (top right corner of the Main Tab), 

and second the photo list updates to display photos from the location selected. That is, based on the 

commands selected. Let’s look at each of these commands individually. 

 

 Get Photo List from Drawing 
 

 

When this command is selected, the program will look at the drawing for photo markers. For each 

marker found, the list will add the related photo to the photo list. 

The Photo Mode Label changes to DWG. 

 

In the example used for this document there are seven markers in the drawing. So, when the Get Photo 

List from Drawing command is selected seven photos are added to the list. See the next image. 



PhotogeoDWG Reference  01.02.01 

Phocaz Inc. © 2018  42 | P a g e  
 

 

 

 Get Photo List from Cloud/Album 
 

 

Use this command to list photos based on the active photo album. See options tab section for 

instructions on selecting and managing photos with a library album. On the options tab, the active photo 

album is set to photogeo3 and the photo list (on the options tab) shows which photos are available in 

this album. 
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On the main tab, we select the Get Photos List from Cloud/Album. This changes the Photo Mode Label 

to A360 indicating we are selecting the photo from a cloud or album location.  

 

And the Photo lsit on the Main Tab changes to match the active album photo list from the Options Tab. 

 

 

 Get Photo List from Local/Network Folder 
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Use this command to list the photos in the active photo folder. The active photo folder is defined on the 

options tab. Path defines the location of the photos. All of the jpeg files located in this folder are read 

into the photo list.  

 

If you are following along the Main Tab is listing the files from the active Album. So, to see this new list 

we need to select the Get Photo List from Local/Network Folder command. The command will change 

the Photo Mode Label. 

 

And the photo list will update to match the options tab photo list for the active photo folder. 
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 Refresh Photos List 
 

 

This command will reload the photo list based on the Photo Mode (top right corner of Main Tab). For 

example, if the active Photo Mode is DWG, then refresh performs the same action as Get Photos from 

Drawing command. The same goes for A360 (Album) and FLDR (Folder) modes. See previous three 

commands for expected results. 

 

 Edit Photo Info 
 

 

Use this command to edit the meta data of the photo. It will open an edit dialog. 

 

All of the text fields on this dialog can be edited. As long as the photo has not been added to the 

drawing the fields will be editable. If the photo has already been referenced to the drawing then these 

fields will be disabled. 

Just below the title is a label that shows you which photograph is active. In this example, IMG_1277.jpg 

is the active photo and it will be selected in the photo list. 
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The top section includes meta data that you add. In other words it’s not data captured by your camera. 

 

ID: This is an index number. It allows you to cross reference photos with the labels in the drawing. Later 

in this section we will look at Auto-number photos which is a command that automatically generates the 

photo IDs for you. So, you don’t have to manually enter IDs for each photo. 

Title: Use this field to enter a photo title. The title is included in the photo list next to the image name. 

 

Photos taken with a smart phone or GPS enabled camera save non-graphic data as part of the image 

(jpeg) file. The GPS location (latitude, longitude, altitude), Title, and Comments are also saved. 

PhotogeoDWG takes advantage of this feature and provides an edit dialog so that you can change this 

information. This same data is used by the Place Labels command. 

Description: Use this field to enter a comment or long description of the photo. 

Project: Use this field to enter a project name. This field will likely be the same for all photos in your 

folder or album. If it is the same, then consider the Bulk Edit command which we will cover next. 
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Keywords: Use the keyword field to enter searchable terms for your photos. Separate keywords with a 

semi-colon. We don’t use this field yet, but plan to provide search capabilities in a future version. 

Authors: Use this field to indicate who created the photo and/or who modified the data. This is a 

manually updated field. Like project, it’s possible this data will be the the same for all photos. In this 

case consider using the Bulk Edit command to change the field for all photos. 

 

Additional Photograph Details 

 

The next section of this edit dialog box contains information that is created automatically when you 

capture a photo with a smart phone or GPS enabled camera.  

For GPS coordinates, we recommend using the command Bulk XYZ to Lat/Lng. We will discuss this 

command later in this section. 

 

Lat: GPS latitude of the camera when the photo is created. 

Lng: GPS longitude of the camera when the photo is created. 

Altitude: Elevation of the camera when the photo is created. The units will be in meters. If you check the 

properties of the marker after placement it will show the elevation of the marker in with the drawing 

coordinate system. In the U.S. this is likely in feet. In this example the camera altitude on the photo is 

207m. The GCS is HARN/16.UTF-16F so the Z coordinate is converted to feet automatically. 

 

 

Size: This is the width and height of the photograph. Use the size fields to make the photo smaller. There 

are no undo options with this feature, so make sure you photos are backed up before using this feature. 

Also, it’s only meant to make the photos smaller. Making them larger will drop resolution. 

Navigation, Save, and Close 

 

Navigation: Four buttons on the bottom left of the form let you move between photos without having 

to close the dialog. The left most button takes you to the first photo in the photo list. The second button 
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moves you one photo up the list, the third button moves one photo down the list, and the fourth button 

moves to the last photo in the photo list.  

Save: The save button saves any changes you made to the photo data. If you close or move to another 

photo without clicking save, the changes will be lost and revert back to the previous data. Clicking save 

will change the data on the photo. There is no undo option. 

Close: Dismiss the dialog box without making any changes to the photo data. 

 Bulk Edit Photo Info 
 

 

Use this command to change the Title, Description, Project Name, Keywords, and/or Authors of all 

photos in the photo list. This command works on ALL photos in the list not just those that are selected. 

This command will not work on photos that are already referenced to the drawing. 

The results of the Bulk Edit are provided in the Command Window. 

 

 

 Bulk XYZ to Lat/Lng 
 

 

Location accuracy is only as good as the devices you are using to capture the feature position. For most 

uses of PhotogeoDWG, survey accurate locations are not really necessary. We would like though, to be 

as close to map accurate as possible, but there are several reasons why the exact location of the photo 

marker will not match the location of the feature. Here are some reasons we know about: 

1) We don’t stand on the feature when we create the photo. We need to stand a distance away 

from the feature to frame it into the camera view. So, the location captured is approximately 

where the camera is when the photo is created. 

2) Smart Cameras are only GPS accurate to approximately 10m (or about 30ft). There are some 

ways to improve this – use a satellite detection enhancement device like the product BadElf. 

This is hardware that plugs into your phone. 
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3) Overcast, tree shade and tall buildings will interfere with location accuracy. We have 

experimented with a WIFI puck with some success. It will also improve the results of reason 

number 2 (above). 

4) Map projection accuracy, like Bing and Google maps are not always dependable. 

 

The Bulk XYZ to Lat/Lng command converts the drawing location the marker, the XYZ coordinate, to a 

new Lat/Lng. This new GPS location is written back to the photo. This allows you to change the location 

of the marker in the drawing to a more accurate position and update the photo GPS location. Now 

labels, and photos will place relative to this new position. Writing new GPS coordinates back to the 

photo also means you can erase markers from the drawing and place them back at the new location. As 

well, you can now share the updated photos with others who might need to make their own drawings 

with these photos and in this case they will have the more accurate GPS location embedded in the 

photos. 

Here’s an example. We take a bunch of photos and when we import them we notice that a camera 

marker shows up in the middle of the highway instead of at the top of the island – and we know that we 

didn’t take any photos standing in the middle of the street.  

 

We can use AutoCAD’s Move command to reposition the marker. Before or after the AutoCAD move the 

GPS coordinates do not change. 
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Move the camera marker to a location closer to the feature (use AutoCAD’s move command). That is, 

improve the accuracy with respect to the map or referenced file. 

 

 

Now run the Bulk XYZ to Lat/Lng command. Just select it from the More commands list. It will ask you if 

you are sure. 

 

 

 

Click OK. 

When it’s complete another message will pop up. 

 

Click OK. 

Now if you Edit the Photo Info, the GPS coordinates will be different. 
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 Auto Number Selected Photos 

Use this command to bulk add IDs and automatically increment the ID number to photos. The Options 

Tab has an Auto-Number field. This is the start value for the ID number. In this example, the start value 

has been set to 200. 

 

This command works on only the Photos selected in the Photo list. So, right click on the photo list and 

Select All photos. 

 

Next, Select the Auto-Number command from the More Commands menu. 
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When the command is finished, a message is written to the Command Window. 

 

On the options tab, the starting Auto-Number changes to the next available number.  
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 Place Single Marker 

 

 

These next three commands are legacy commands from the very original PhotogeoDWG program. They 

allow the user to place markers, photos, and images one at a time. Each control is interactive and 

requires extra input to finish the placement. But, each provides more control over placement. 

Use Place Single Marker to add individual camera marker to the drawing. When you select this 

command, several new controls will display along the top of the Main Tab. 

 

Name: This is a text box. It lets you provide a Photo name. It can be anything you want.  

Path: This is also a text box. You can type the location of the photo jpeg you want to place in the 

drawing (if you know it). 

Or, you can use the browse button located immediately to the right of the text box. (spy glass 

icon).  

The browse icon will open a standard windows file open dialog. Navigatge the photo you want to place 

in the drawing. Select Open. 
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So, with a name and photo defined the dialog will look similar to this… 

 

 If you like this then use the accept button (the check mark icon) to start the placement. If on 

the other hand you decide you don’t want to do this now, select X icon to cancel (this will 

dismiss the extra controls). 

A) As you place the marker it will show the placement position until you place it at, 

B) The marker will rotate (if the Options Tab Rotate checkbox is checked) and complete placement. 

 

CAUTION: This might not be what you want. If you placed a photo from the photos folder as a single 

camera marker, and you have the camera marker at the original position the original photo position will 

be replaced by this new position.  

It’s more likely that this single file comes from some other folder, so you don’t have to be as concerned 

about the position change. Make sure though that you don’t plan to use the original coordinates from 

the photo because they will be lost. 
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 Insert Image  

 

Select a photo from the list box and then select this command to place the image in the file.  

It will expect two points (similar to place shape). Points 1 and two represent the datapoint locations. 

 

 

 Place Single Label  

 

Use this command to interactively place a single label into the drawing.  

Just like it’s multi-label counterpart, the label command reads ID, Title, Description, Project Name, 

Keywords, Authors, and GPS location from the photo file. Use the Options Tab and Label Settings to tell 

the command which data attribute to include in the label. Interactive placement is as simple as placing a 

single point in the drawing. 
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 Export Photo View to CSV File 

 

 

The Export Photo View (List) to CSV File command is used to create a comma separated file containing 

all of the attributes of the photos in the photo list. This command reports on photos selected in the 

photo list. 

Here are the steps. 

1) Select the photo(s) you want to export (from the photos list). 
2) Select the command from the More Commands menu. 
3) Browse to a location and provide a new file name in the standard windows save dialog that opens. 
 

 
 
4) Click Save. Or, click Cancel to stop the process and start over. 
 
The command will tell you when it is finished by writing a message to the Command Window. 

 

 
If you clicked Save, the More Commands menu will change slightly. Notice that the button below the 
Export command now says Open >> C:\demo\test01.csv instead of C:\demo\aldot01a01.csv. This new 
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file name is the file we just saved. If you click this button, it will use the default application set to open 
this file. For most that’s likely Excel or Notepad. 
 

 
 
5) So, click this button to open the new CSV file. 
 
 

 Open Help Reference Guide (PDF) 

 

 

Use this command to open this help document. 

 

The Map View 
Just below the Main Tab Commands is the Map View.  

 

This section is expandable. Click and drag on the orange bar (bottom of this image) located between the 

map view and the photo viewer. 

The Map view is displayed when you select a photo from the photo list. It shows a single marker 

indicating the photo in the photo list that was selected first. 

Map Controls 
Zoom - Along the top of the Map View are five additional controls. The first two (from left to right) are 

zoom in and zoom out. Use these commands to change the resolution of the map view.  

Open in Google Maps – This is a hyperlink button. When clicked, the command will open the default 

browser and display the photo location in Google Maps. 
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Roadmap View Checkbox – when checked, roads and road names are shown. 

Satellite View Checkbox – when checked, satellite imagery is displayed in the map view. 

Both of these check boxes can be checked at the same time. When both are unchecked, the roadmap 

view is displayed. 

The Photo Viewer 
The next section located below the map is the photo viewer. 

Zoom 
Use the mouse wheel to zoom in or out. 

 

Pan 

You can also click and hold left mouse button to pan. 
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Photo List View 
The photo list displays the active photo list as defined by the Photo Mode.  

 

 

The Photo Mode label indicates where the photos in the photo list come from. The Photo Mode is 

indicated in the top right corner of the Main Tab. 

 

There are three places that the list can be read from,  

• a folder  

• a library album  

• the drawing  

The Photo List is the tool used to select photo(s) to work on or with. For example, the placement 

commands expect that you select photo(s) before the will work. Refer to the command sections above 

to learn which commands require photos to be selected. 

Right-Click Menu – More Options 
The last set of menus are the “right-click” menus. As the name suggests, they are activated when you 

right click on the photo list.  
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 Select ALL This command selects all of the photos in the list. We have seen this command in the 

getting started section it’s simple to use. Just right-click and then click on the first option. All of the 

photos will be selected. 

 

  Add Camera Marker(s) and Insert Photo in DWG were included here for convenience. We are 

considering removing them in future versions to improve user experience. 

 Show in Folder / Browser  This command locates the file in a folder location if located on a local or 

networked (internal) drive. Or if the file is located on a web server it will open the file in a browser. 

Here’s an example of what it looks like when the file is local - window is opened and the image is 

selected. 
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 Zoom to XY When clicked, the program searches the design file for the photo’s camera marker. It 

then window areas the marker and automatically zooms the view. 

 

Select the command to zoom about the camera marker. 
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It’s not shown here, but the camera marker is centered in the view.  

 Highlight Camera Marker(s) Select photos in the list box then run this command and the camera 

markers will highlight.  

 

 Remove Highlight is a convenient way to remove all highlights. 

 

  



PhotogeoDWG Reference  01.02.01 

Phocaz Inc. © 2018  64 | P a g e  
 

The Options Tab 
As the name suggests, the Options tab is used to set properties that control PhotogeoDWG.  

 

This document has shared some of these features already, so this section will provide details for each 

control. 

After using PhotogeoDWG for the first time, the top of the Options Tab looks like it does in the image 

above. The only controls are 1) the tab title, OPTIONS, and 2) the help button which opens this 

document. 

If this is the first time using the program, then the top of the tab will look more like this, 

 

In this case, you can click the Try Sample button to load the delivered examples. The rest of this section 

will assume this is not the first time since this is covered at the beginning of the document. 
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Photo Location (Local or Network Folder)  
When you want your photos to be stored either locally or on a networked server this control will point 

to that location. 

 

 

 You can type a new path (folder location) or you can use the spy glass button to browse for the 

folder. 

 The round button next to browse will refresh the Options Tab photo list.  

 

Album Location (XML File) 
The Album Location controls display when the toggle button to the right of the Photo Location label is 

clicked. 

 

Path – this textbox now contains the location of the active photo library file.  

 You can type a new path (xml file location) or you can use the spy glass button to browse for the 

file. 

 Create New Album Library – Use this command to create a new empty XML library file. 
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After entering a new library file name, click Save. This will change the path to match this new file and 

location. 

 

When you change to the Album Location from the Photo Location controls a new list expands to show 

the Library Albums. 

 

So, when you create a new library, there are no albums in the list. And, it will look collapsed. (See 

Add/Delete below). 

 

 The round button next to browse will refresh the Options Tab photo list.  

 

 Add Album – add an album to the library file. 

When you click the Add Album button new controls will display below the Path controls. 

 

Type a name for the album – it can be anything you want but should not already exist in the album list. 

Since we are starting with a new library the name can be anything.  
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So, we will just type MyNewAlbum01 and click the Check mark to the right of the New Album textbox. 

 

So, when you click the check mark this new name is added to the Album list. 

 

If we add a second Album, MyNewAlbum02 it will be appended to the list. 

 

 Delete Album – remove an album from the library file. 

An Album can be removed. If you highlight the album name in the list. Click the minus button to delete 

it. 
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Adding Photos to Albums 
This is probably the easy part. Just drag and drop. 1) First, highlight the album you want to populate with 

photos. 2) Then next, select from a file folder the photos you want to include in the album. 3) Drag (click 

and hold) the photos into the photo list. 4) Drop the photo files into the photo list. 
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The Photo Library 
The idea of a photo library and albums may seem a little tricky at first, but it’s not really. Think of a 

physical library that has books. In this case the books are photo albums. And the albums contain photos 

you are interested in. It’s a way to manage photos in the same or multiple locations. When you use the 

folder option to list photos it’s an all or nothing approach. With albums though, you can choose which 

photos from a folder you want to include in the list. 

A Photo Library is an XML file. It can be edited with and ASCII text editor like notepad. The file is just a 

list of photos and their locations. A location can be a path to the photo file on a local or network 

location, or it can be an internet location with an http address. 

 

The Photo List 
This is the view of the photo list you are working on currently. It is not necessarily the same view as the 

view on the Main Tab. It is the view based on the Photo Location or Album option. The program will 

remember the last Photo Folder and the last select Album which it then uses in the Main Tab (both can 

be selected at the same time, but as we’ve seen only one is active on the Main Tab at any given time). 
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Command Options 
The bottom section of the Options Tab contains command options which control how the program 

works and which resources (other than photos) to use. 

 

 

 

Block Layer  

 

Use Block Layer to set the layer for the camera block. If set the program will use the layer name if it is 

defined. If the layer is not defined, PhotogeoDWG will add it to the layer table. If the layer is empty then 

the program will add the block to layer 0.  

 

Camera File  

 

Use the Camera File option to set the location of the camera file. Type the file path and name of the 

drawing file containing the Camera block(s). 

 

Or, use the browse button located to the right of the Camera File text box. When you select this 

control, the AutoCAD file Open dialog appears. Browse to the location of the drawing you want to 

use. The format for the file you select must match the version number format. For AutoCAD and Civil 3D 

2015 through 2017, use a 2013 DWG file format. And for newer versions 2018 and 2019, use a 2018 file 

format.  
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The program comes with both of these formats and default camera files. There are two versions of each. 

The first drawing contains the original block style delivered with the first version of PhotogeoDWG – use 

camera2013.dwg and camera2018.dwg for this style. And a newer style with rounded edges is available 

in camera2013_02.dwg and camera2018_02.dwg. 

 

You can make your own blocks. Create your blocks using the block editor. The camera drawing can 

contain more than one block (see below to learn how to select a block). The block does not have to be a 

camera. In a future release we will let you define a block name for each photo. This way you can assign a 

different block for each feature type. If you want the camera to work with the rotation option then draw 

your blocks so that the camera lens is at 0,0,0 and facing down.  
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Camera Name  

The block to use when inserting camera markers into the drawing. Use the browse button to select from 

a list of cameras in the Camera File. 

 

The list of blocks (cameras) is read from the Camera file. PhotogeoDWG reads the block table to get the 

blocks and displays them in this list. As described in the previous section, there can be multiple blocks in 

this Camera file. 

AutoNumber  
This option defines the start index for the auto number command. Auto number is used to bulk add IDs 

to photos and it automatically increments the ID between photos. Auto Number on the Options tab 

defines the start point. See Auto-number Photo IDs in More Commands popup located on the Main Tab. 

You define the index number to start at and PhotogeoDWG will update it to the next available index 

each time the command is run.  
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Label Settings 
Click the plus button next to the Label Settings label to reveal options used to control how labels are 

drawn. Click the plus sign again to hide these options. 

 

Layer Name – Use this options to set the layer name for the label. The program will add the layer to the 

layer table if it doesn’t already exist. Layer 0 is used if this text box is empty. 

Y Offset – Distance along the Y axis from the camera marker origin. Use this option to tell PhotogeoDWG 

to place the label Y Offset away from the origin of the marker. This will help to avoid overlapping details 

when auto-generating the drawing. That is, there will less clean-up required. 

X Offset – Distance along the X axis from the camera marker origin. Use this option to tell PhotogeoDWG 

to place the label X Offset away from the origin of the marker. This will help to avoid overlapping details 

when auto-generating the drawing. That is, there will less clean-up required. 

Label ID – when checked, the photo ID is included in the label. 
Label Title – when checked, the photo Title is included in the label. 
Label Comment – when checked, the photo Description is included in the label. 
Label Project – when checked, the Project photo Name is included in the label. 
Label GPS – when checked, the photo GPS Coordinates are included in the label. 
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Image Settings 
Click the plus button next to the Image Settings label to reveal options used to control how images are 

drawn. Click the plus sign again to hide these options.  

 

Width – The size to draw the photo measured along the X axis. 

Height – The size to draw the photo measured along the Y axis. 

Offset Y – Distance along the Y axis from the camera marker origin. Use this option to tell PhotogeoDWG 

to place the label Y Offset away from the origin of the marker. This will help to avoid overlapping details 

when auto-generating the drawing. That is, there will less clean-up required. 

Offset X – Distance along the X axis from the camera marker origin. Use this option to tell PhotogeoDWG 

to place the label X Offset away from the origin of the marker. This will help to avoid overlapping details 

when auto-generating the drawing. That is, there will less clean-up required. 

 

Google Maps API  
Enter your Google Maps API Key here. See detailed explanation starting on p. 35. 

 

 

Web Proxy  
The program will attempt to Auto-detect the web proxy if there is one. If for some reason it will not 

detect, use this option to open a dialog that will let you explicitly identify the proxy and enter your 

credentials. 

The known proxy issue is that some organizations want to block google applications and APIs. We use 

Google Maps API for the map viewer and we check for this address, 
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http://maps.googleapis.com/maps/api/staticmap?center=0,0&size=1x1&zoom=1&maptype=roadmap 

Most network admins are OK with opening access to these APIs if needed. If you are having trouble 

getting the map view, this could be the issue. 

 

 

 
 

Show Camera Direction  
If checked, the camera will rotate to show the orientation the photo was taken. When creating a new 

camera block, the camera front needs to be pointing in the positive Y direction (to the top of the 

drawing view - i.e. in an unrotated view) 

 

Highlight Marker  
When checked, the camera markers will highlight in the drawing as soon as the list box row is clicked. 

This option will impart a performance hit when there are more than 50 markers, so use wisely – you can 

always turn it off. 

 

http://maps.googleapis.com/maps/api/staticmap?center=0,0&size=1x1&zoom=1&maptype=roadmap
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Work Offline 
For many reasons internet may not be available. In this case you can tell PhotogeoDWG to work offline. 

In this mode it will skip and internet look-ups. This means that all of your photos must be on your 

computer or close by, but PhotogeoDWG will work just fine off-line. You will just have to use offline 

maps and drawings. 

 

 

Saved User Settings 
User settings are saved to an XML file called UserSettings.xml. This file is user specific, so it is saved in 

the following location. 

C:\Users\[Users Login Name]\AppData\Roaming\Phocaz\PhotoGeo\ 

This is a text file, it can be edited, and it can be shared if you want to deploy a common settings to all 

users. But, since these are user preferences the end use can change them after install and will diverge 

between users over time. 
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Administrative 
Log File 
PhotogeoDWG tracks when errors occur and write these to a log file. The log file is located here, 

C:\Users\[Users Login Name]\AppData\Roaming\Phocaz\Logs\PhotogeoDWG.Log 

Issues would be program and maintenance related and not necessarily created by the end user. We 

believe that our program is stable, but errors do occur, and the log file is a tool we can use to see what 

happens during program operation. 

When an error does occur, and you would like to reach out to use for help, please include the log file 

along with your problem description.  

 

AutoCAD Account Sign In 
To use PhotogeoDWG you will need to sign into your AutoCAD account. This is Autodesk’s method for 

verifying and authorizing the use of Add-ins. As long as your subscription is current, the login will 

authorize your use of the application 

 

A 30-day Trial is available when you download the application. And, if you don’t find the program useful 

you may return it.  

Grace Period – you must login at least one time every seven days to verify you are entitled to use the 

application. If for some reason you are unable to connect to the internet then the program will still work 

for up to 7 days. You will still get prompted to login. But if you click ok the program will load and show 

that you have a remaining grace period. 

 

If you have never run this program before, you will have to be on-line to load it the first time.  

 

Install Folder 
We are using the bundle approach introduced by Autodesk several years ago. This allows us to install 

the program into a single location supported by AutoCAD’s auto-load feature. The program does not add 

any registry data (not during install, and not during operation). The install folder name is 

Phocaz_PhotoGeoDWG.bundle. The default install location is C:\Program 

Files\Autodesk\ApplicationPlugins\. Autoload will look in this folder for any bundles and load them into 

the Add-In menu. You will also find autoloaded add-in bundles in 

C:\ProgramData\Autodesk\ApplicationPlugins\ and in C:\Users\[Your User 
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Name]\AppData\Roaming\Autodesk\ApplicationPlugins\.  This last folder is user specific, so if you are a 

CAD Manager installing the plugin for someone else, be sure to use their login if you want to add the 

add-in to this folder. Otherwise, choose one of the previous folders. 

 

Startup Scenarios 
PhotogeoDWG uses Autodesk’s Entitlement API to authorize usage. Each user must be logged into their 

Autodesk Account. 

 

1) If you do not log in before running Photogeo then the program will pop up the Autodesk Account 

login. 

 

If this happens, log in and then click the PhotogeoDWG command icon again. That is, click this icon, 

 

If the user is authorized (entitled) then the program will load.  
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2) If your subscription hasn’t expired, or the trial period has ended (30 days) then you will be asked to 

purchase the program. 

 

Click Visit the App Store to open the app store in your default browser. The dialog will be dismissed 

when you click this button. 

If you click “I’ll do this later” the dialog will dismiss. 

3) If you are authorized but cannot log in the program will still run. In this case the program will display 

the login box (you are not logged in because you don’t have internet), and PhotogeoDWG will display. 

Click the X in the login box (may have to click 2 times) to dismiss the box. The Command Window will 

show you how many days you have remaining until you have to get back on-line. 

 

This means you must log in to your Autodesk account and start PhotogeoDWG at least one time every 7 

days. If you do not then the program will fail to load. 
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